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xPC Target 1/0O Library

xPC Target is a solution for prototyping, testing, and deploying real-time
systems using standard PC hardware. In support of this, xPC Target allows
you to add I/O blocks to your model. I/O blocks in xPC Target provide a
particular function of an I/0O board. By using I/O blocks in your model, you can
generate executable code tuned specifically for your hardware. This chapter
includes the following sections:

I/O Driver Blocks (p. 1-2) Introduction to the xPC Target I/O
library of driver blocks

Adding I/O Blocks with the xPC Adding I/O blocks to a model using

Target Library (p. 1-11) the xPC Target library

Adding I/O Blocks with the Simulink Adding I/O blocks to a model using

Library Browser (p. 1-15) the Simulink® library browser

Defining I/O Block Parameters Configuring I/O driver blocks

(p. 1-20)
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1/O Driver Blocks
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You add I/O driver blocks to your Simulink model to connect your model
to physical I/O boards. These I/O boards then connect to the sensors and
actuators in the physical system. This section includes the following topics:

® “I/O Driver Block Library” on page 1-2

* “Memory-Mapped Devices” on page 1-5

e “PCI Bus I/O Devices” on page 1-6

e “)PC Target I/O Driver Structures” on page 1-7

e “Updated Driver Information” on page 1-10

Refer to the following sections for descriptions on how to add I/O blocks to
your model, and how to configure those blocks:

e “Adding I/O Blocks with the xPC Target Library” on page 1-11

® “Adding I/O Blocks with the Simulink Library Browser” on page 1-15

® “Defining I/O Block Parameters” on page 1-20

1/O Driver Block Library

A driver block does not represent an entire board, but an I/O section supported
by a board. Therefore, the xPC Target library can have more than one block
for each physical board. I/O driver blocks are written as C-code S-functions
(noninlined S-functions). The source code for the C-code S-functions with
xPC Target is included.

xPC Target supports PCI and ISA buses. If the bus type is not indicated in
the driver block number, you can determine the bus type of a driver block by
checking the block’s parameter dialog box. The last parameter is either a PCI
slot, for PCI boards, or a base address, for ISA boards.

You can open the I/O device driver library with the MATLAB® command
xpclib. The library xpclib contains sublibraries grouped by the type of I/O
function they provide.



I/O Driver Blocks

Note Opening a dialog box for a source block causes Simulink to pause. While
Simulink is paused, you can edit the parameter values. You must close the
dialog box to have the changes take effect and allow Simulink to continue.
In particular, hardware input blocks in the xPC Target library (blocks that

acquire data from hardware) are affected by this change.
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This window also contains the following blocks:

e xPC Target Driver Demos — When you double-click this block, the
sublibrary opens, displaying a list of xPC Target driver demo groups.

¢ Help for xPC Target — When you double-click this block, the xPC Target
roadmap page is displayed. You can access the xPC Target documentation

with this block.

1-3
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When you double-click one of I/0O block groups, the sublibrary opens,
displaying a list grouped by manufacturer as shown below.

[ZlLibrary: npclib/a/D =10l x|

File Edit Wiew Format Help

wl ] B B

Advantech Anakbgic Measumrment Contes Dtz Diarpond  Geneml  Hurmusoft
Computing Transktion Standamds

wl m| mlopel el pel Pl

Keithlay Mational Cuanser  Real Time SES Sensomy LEI Versakbgic
etmbyte [nstruments Cevizes Technolgies

Double-clicking one of the manufacturer groups then displays the set of I/O
device driver blocks for the specified I/O functionality (for example, A/D, D/A,
Digital Inputs, Digital Outputs, and so on).



I/O Driver Blocks

The following figure shows the A/D drivers for the manufacturer Measurement
Computing, Inc.

E!Lihrary: xpcmeasurementcomputinglib /A /| - | [m) il
File Edit View Format Help
CIO-DASIBIR CIO-DAS1601/12 CIO-DAS1602M2 CIO-DAS1G330 CIO-DASIG/r EXP
GomputerBoamds 1 ComputerBoams 1 GomputerBoamds 1 GomputerBoamds 1 ComputerBoams
Analg Input Anabg Input Analog Input Anabg Input Analg Input
CIo-DAs18 JR CIO-DAS1B01 12 CI0-DASTE02 12 CIC0-DAS1E 320 CI0-DAS1BJR EXF
CIO-DASTEIRAE CIO-DAS1B0Z/16
GomputerBoamds 1 GomputerBoamds 1
Anakg Input Anabg Input
CIo-DASIBIR 16 CIO-DAS1B02 18
PC104-DAS16IRAZ PC104-DAS1BJRAE
GomputeBoamrs 1 CamputerBoams 1
Anakg Input Anabg Input
PG104-DAS1BIR 12 PG104-DASTEIR 16
PCI-DAST200LR PCI-DAS 1200 PGI-DASTBO2MZ PCI-DAS 1802418
GomputeBoamrs 1 CamputerBoams 1 GomputeBoards 1 GomputerBoads 1
Analog Input Anakg Input Analog Input Anakg Input
PGCI-DAS1200 JR PGCI-DAS1200 PCI-DASTBE02 12 PCI-DASE02 16
PCIM-DAS 1802116
GomputeBoands 1
Anaiog Input
PGIM-DASIE0E 16

When you double-click one of these blocks, a Block Parameters dialog box
opens, allowing you to enter hardware-specific parameters. Parameters
typically include

* Sample time

e Number of channels

® Voltage range

PCI slot (PCI boards)

Base address (ISA boards)

Memory-Mapped Devices

Some supported boards in the xPC Target I/O library are memory-mapped
devices, for example, Burr-Brown boards. These memory-mapped boards are
accessed in the address space between 640 K and 1 MB in the lower memory
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area. xPC Target reserves a 112 KB memory space for memory-mapped
devices in the address range

CO0000 - DBFFF

Some drivers for memory-mapped devices allow you to select an address range
supported by the device, but not supported by xPC Target. For example, the
CAN drivers for Softing allow you to select memory ranges above DBFFF.
Base addresses of memory-mapped devices must be chosen within this
memory space for your target application to work properly. Select a memory
range supported by both the device and xPC Target.

ISA Bus 1/O Devices
There are two types of ISA boards:

® Jumper addressable ISA cards
® PnP (Plug and Play) ISA cards

xPC Target only supports jumper addressable ISA cards (non-PnP ISA boards)
where you have to set the base address manually.

PCI Bus 1/0 Devices

The xPC Target I/0 library supports I/0 boards with a PCI bus. During the
boot process, the BIOS creates a conflict-free configuration of base addresses
and interrupt lines for all PCI devices in the target system. The user does not
need to define any base address information in the dialog boxes of the drivers.

All PCI device driver blocks have an additional entry in their dialog boxes.
This entry is called PCI Slot (-1 Autodetect) and allows you to use several
identical PCI boards within one target system. This entry uses a default
value of -1, which allows the driver to search the entire PCI bus to find the
board. If you specify a single number, X, greater than 0, the driver uses the
board in bus 0, slot X. When more than one board of the same type is found,
you must use a designated slot number and avoid the use of autodetection.
For manually setting the slot number you use a number greater than or equal
to 0. If the board is not able to locate this slot in the target PC, your target
application will generate an error message after downloading.
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If this additional entry is set to any value equal to or greater than 0, you
must be aware of the manufacturer’s identification number (Vendor ID) and
the board identification number (Device ID) of those boards supported by the
I/0 library. When the target is booted, the BIOS is executed and the target
PC monitor shows parameters for any PCI boards installed on the target PC.
An example is shown below:

Bus No Device Func. Vendor Device Device IRQ
No. No. ID ID Class

0 4 1 8086 7111 IDE 14/15
controller

0 4 2 8086 7112 Serial bus 10
controller

0 11 0 1307 000B Unknown N/A
PCI device

1 0 0 12D2 0018 Display 11
controller

In this example, the third line indicates the location of the Measurement
Computing PCI-DIO48 board. This is known since the Measurement
Computing vendor ID is 0x1307 and the device ID is Oxb. In this case, you
now can see that the Measurement Computing board is plugged into PCI slot
11 (Device No.), and that this value must be entered in the dialog box entry in
your I/O device driver for each model that uses this I/O device.

xPC Target 1/O Driver Structures

Properties for xPC Target I/0O drivers are usually defined using the parameter
dialog box associated with each Simulink block. However, for more advanced
drivers, the available fields defined by text boxes, check boxes, and pull-down
lists are inadequate to define the behavior of the driver. In such cases, a
more textual description is needed to indicate what the driver has to do

at runtime. Textual in this context refers to a programming-language-like
syntax and style.

xPC Target currently uses a string description contained in message
structures for the conventional RS-232, GPIB, CAN (initialization), and the
general counter drivers (AMD9513).
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What is a message structure? — A message structure is a MATLAB array
with each cell containing one complete message (command). A message
consists of one or more statements.

Furst message Second message Third message

Message(l).field | Message(1).field | MMessage(l).field
Message(l).field | Message(1).field | Message(l).field
Message(l).field | Message(1).field | Message(l).field

Syntax of a message statement — Each statement in a message has the
following format:

Structure_name(index).field name = <field string or value>

The field names are defined by the driver, and need to be entered with the
correct upper- and lowercase letters. However, you can choose your own
structure name and enter that name into the driver parameter dialog box.

Creating a message structure — You could enter the message structure
directly in the edit field of the driver parameter dialog box. But because the
message structure is an array and very large, this becomes cumbersome
very easily.

A better way is to define the message structure as an array in an M-file and
pass the structure array to the driver by referencing it by name. For example,
to initialize an external A/D module and acquire a value during each sample
interval, create an M-file with the following statements:

Message
Message
Message
Message

senddata="'InitADConv, Channel %d'
inputports=[1]

recdata=""

outputports=[]

—_— o~~~

1).
1).
1).
1).

Message
Message
Message
Message

2).senddata='Wait and Read converted Value'
2).inputports=[]

2).recdata="'5%f"'

2).outputports=[1]

—_— o~~~

This approach is different from other xPC Target driver blocks:



I/O Driver Blocks

® The M-file containing the definition of the message structure has to be
executed before the model is opened.

After creating your Simulink model and message M-file, set the preload
function of the Simulink model to load the M-file the next time you open
the model. In the MATLAB window, type

set_param(gcs, 'PreLoadFcn', 'M-file_name')

® When you move or copy the model file to a new directory, you also need to
move or copy the M-file defining the message structure.

During each sample interval, the driver block locates the structure defined
in the Block Parameters dialog box, interprets the series of messages, and
executes the command defined by each message.

Specific drivers and structures — For detailed information on the fields in
a message structure, see the following chapters in this document:

e Chapter 2, “Serial Communications Support”
¢ Chapter 3, “GPIB I/O Support”
e Chapter 4, “CAN I/O Support”

PWM and FM Driver Block Notes

In PWM and FM driver blocks, your control over the output frequency and
duty cycle is not always precise. In particular, these values are affected by
the way that the base frequency is selected, as described in this section. The
base frequency value is exact.

At the beginning of each sample time, two unsigned 16-bit integers, n and m,
are computed based on the block parameters and the current values of the
input signals. During the current sample period, the output signal is held
high for m cycles of the base frequency, low for the next n-m cycles, high for the
next m cycles, and so forth.

1-9
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For a base frequency b, this results in a rectangular output signal of frequency
b/n and duty cycle m/n. Because m and n must be integers, it is not possible
to provide a continuous range of output frequencies and duty cycles with
perfect exactness.

For example, assume that you want to configure an FM block with a duty
cycle (m/n) of 1/2. The input signal f to this block is a relative frequency. It
specifies an output frequency of b x f. Because m and n must be integers, it is
not always possible to find values of m and n such that f will equal b/n exactly
and n will equal 2 x m (duty cycle m/n = 1/2) exactly. Such an exact match is
only possible when the input signal f equals 1/4, 1/6, 1/8, and so forth. The
output frequencies for the intervening input signal f values are approximate.
The errors are smaller as f approaches 0 and larger as f approaches 1.

Hint, to achieve the smallest margin of error, select the largest possible base
frequency. The fact that n and m must be 16-bit integers imposes a lower limit
of b / (2% - 1) on the frequencies that can be generated using a given
base frequency.

Updated Driver Information

Because new drivers are always being added, and existing drivers are always
being updated, not all of the information about these drivers is included in
the online or printed documentation.

For updated and additional driver information, see the developer Web site at

http://www.mathworks.com/support/product/XP/productnews/
productnews.html


http://www.mathworks.com/support/product/XP/productnews/productnews.html
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Adding 1/0 Blocks with the xPC Target Library

xPC Target includes a Simulink block library for I/O drivers. The highest
hierarchical level in the library is grouped by I/O function. The second level is
grouped by board manufacturer. The manufacturer groups within this second
level contain the driver blocks for specific boards.

This procedure uses the Simulink model xpc_osc.mdl as an example of how
to add and connect I/O blocks:

1 In the MATLAB window, type
xpclib
The Library: xpclib window opens.

=1E

File Edit “iew Formab Help

#¥PC Target Block Library

il
el
[ 7]
]
]
|
|
il
il
]
7]
]

A a2 Digital Drigital Counter  Watchdog Incremental
Frame Input Qutput Encoder

Synchro ARINC-429 MIL-STD
Resolver 1553

] e
L&
]
b
b
|
|
a
<] &
P
]
P

RE232 GPIB Audio CAN LELD Themao Signal Shared IP Carrier Mizc.  Asynchronous  UDP Lilities
couple Conditioning Memory Event (Beta)
®PC Target Warsion 2.0 Help for
Driver Demaos Copyright 1996-2006 The Mathiliods, Inc. #*PC Target

Alternatively, you can access the I/O driver library with the Simulink
Library Browser. See “Adding I/O Blocks with the Simulink Library
Browser” on page 1-15.

2 Open a function group. For example, to open the A/D group, double-click
the A/D block.
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The manufacturer level opens.

ZiLibrary: xpclib/a, =10l

File Edit Wiew Format Help

wl ] B B

Advantech Anakbgic Measumrment Contes Dtz Diarpond  Geneml  Hurmusoft
Computing Transktion Standamds

wl m| mlopel el pel Pl

Keithlay Mational Cuanser  Real Time SES Sensomy LEI Versakbgic
etmbyte [nstruments Cevizes Technolgies

Within each manufacturer group are the blocks for a single function.
3 Open a manufacturer group. For example, to open the A/D driver

blocks from Measurement Computing, double-click the group marked
Measurement Computing.
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The window with the A/D driver blocks for Measurement Computing opens.

E!Lihrary: xpcmeasurementcomputing| _|E| il
File Edit View Format Help
CIO-DASIBIR CIO-DAS1601/12 CIO-DAS1602M2 CIO-DAS1G330 CIO-DASIG/r EXP
GomputerBoamds 1 ComputerBoams 1 GomputerBoamds 1 GomputerBoamds 1 ComputerBoams
Analg Input Anabg Input Analog Input Anabg Input Analg Input
CIo-DAs18 JR CIO-DAS1B01 12 CI0-DASTE02 12 CIC0-DAS1E 320 CI0-DAS1BJR EXF
CIO-DASTEIRAE CIO-DAS1B0Z/16
GomputerBoamds 1 GomputerBoamds 1
Anakg Input Anabg Input
CIo-DASIBIR 16 CIO-DAS1B02 18
PC104-DAS16IRAZ PC104-DAS1BJRAE
GomputeBoamrs 1 CamputerBoams 1
Anakg Input Anabg Input
PG104-DAS1BIR 12 PG104-DASTEIR 16
PCI-DAST200LR PCI-DAS 1200 PGI-DASTBO2MZ PCI-DAS 1802418
GomputeBoamrs 1 CamputerBoams 1 GomputeBoards 1 GomputerBoads 1
Analog Input Anakg Input Analog Input Anakg Input
PGCI-DAS1200 JR PGCI-DAS1200 PCI-DASTBE02 12 PCI-DASE02 16
PCIM-DAS 1802116
GomputeBoands 1
Anaiog Input
PGIM-DASIE0E 16

4 In the Simulink window, type
XpC_osc
The Simulink block diagram opens for the model xpc_osc.mdl.

=0l x|

E!Hpc_usc
File Edit Wiew Simulation Format Toaols Help
nooo 100072
ve ¥ 24005100072
Signal Transfer Fen
Generator -
Scopel

*PC Tamet tutonial rmodel

5 From the block library, click and drag the name of an A/D board to the
Simulink block diagram. Likewise, click and drag the name of a D/A board

to your model.
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1-14

Simulink adds the new I/O blocks to your model.

6 Remove the Signal Generator block and add the Analog Input block in its
place. Remove the Scope block and add the Analog Output block in its place.

The demo model xpcosc should look like the figure shown below.

—ioix]

File Edit Wiew Simulation Format Tools  Help

GIO-DAS1602/16 10o0o0n2
GormputerBoads 1 | 3
Analag Input g4 +4005+100042 S16-DAS1602HE
1 GomputerBoamds
Gl -DAS1602 16 Transfer Fcn ﬂn:bg Ciutput
| .
Ll

Glo-DM 51602 16 1
*PiC Tamet tutonal model

You cannot run this model unless you have the I/0 board shown installed in
your target PC. However, you can substitute the driver blocks for another
I/0O board that is installed in the target PC.

Your next task is to define the I/O block parameters. See “Defining I/0 Block
Parameters” on page 1-20.
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Adding 1/0 Blocks with the Simulink Library Browser

xPC Target includes a Simulink block library for I/O drivers. The highest
hierarchical level in the library is grouped by I/O function. The second level is
grouped by board manufacturer. The manufacturer groups within this second
level contain the driver blocks for specific boards.

This procedure uses the Simulink model xpc_osc.mdl as an example of how
to add and connect I/O blocks:

1 In the MATLAB window, type

XpC_o0sc

The Simulink block diagram opens for the model xpc_osc.mdl.

[S1xpc_osc =]

File Edit Wiew Simulation Format Toaols Help

nooo 100072
0o *| STea00s+10002
Signal Transfer Fen
Generator -

Scopel

*PC Tamet tutonial rmodel

2 In the Simulink window, from the View menu, click Library Browser.
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The Simulink Library Browser window opens. Alternatively, you can
open the Simulink Library Browser by typing simulink in the MATLAB
Command Window.

E! Simulink Library Browser — |EI|£|

File Edit Yiew Help

0= 4adh |
Commonly Used Blocks: simulink/Commanly
Uszed Blocks
- | Simulink. 21 [ commart
..... 2] Commonly Used Blocks U= bloczs
..... g Continuous
----- 2| Discontinuities EortineLs
..... | Discrete
..... 2 Logic and Bit Operations
----- 2+ Lockup Tables
..... 2+ Math Operations
..... | Model verification
..... B Madel-Wide Utilities
----- 2] Ports & Subsystems
..... | signal Attributes
..... | Signal Routing

..... ySinks =
J I_>l_|m

You can access the xPC Target I/O library by right-clicking xPC Target
and then clicking Open the xPC Target Library.

Commanly Used Blo

Discontinuities

b

Discrete

-
_—

fi il

Logic and Bit Operations

Lookup Tables

E

"+

I ath Operations LI
%

Alternatively, you can access driver blocks using the xPC Target I/O driver
library. See “Adding I/0 Blocks with the xPC Target Library” on page 1-11.
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3 Double-click xPC Target.

A list of I/O functions opens.

E! Simulink Library Browser - IEllil

File Edit ‘iew Help

D& =

| AJD: Select the zettings for the subsystem block.

- B Real-Time Warkshop ;I
B Real-Time Wworkshop Embedded Code
W& Simulink. Extras

] Stateflow

E|§| *PC Target

-2 AfD

- B AJD Frame
.- I BRINC-429

----- g Asynchronous Event
- 2+ Audio
- 3 Can

- I Counter
H

H

AD

AZD Frame

ARIMC-423

[l

Azynchronous Event
Audio

-3 pja CEN

- 2] Digital Input -
1| | »

Ready

Fr O e IO e R B

A W i A A

Counter LI
%

4 Open a function group. For example, to open the A/D group for
Measurement Computing, double-click A/D, and then click Measurement
Computing.

1-17



1 xPC Target 1/O Library

A list with the A/D driver blocks for Measurement Computing opens.

E! Simulink Library Browser — |EI|£|
File Edit Yiew Help
DS 4 éh |
CI0-DAS16 330 : CI0-DASTE/300
ComputerB oards
=2 A I | e
----- 2] Advantech e

----- - e

..... 2' Contec ClO-DASTEJR

..... #+| Data Translation

----- 2' Diarnond ClO-DASTEOT 12

----- 2+ General Standards J

----- # Humusoft st

| i CI0-DASTR0Z 12

..... | Keithley Metrabyte

----- 2 i Sou e oL e+ | CI0-DASTE02 16

----- 23] Mational Instruments A e

..... ¥ Quanser [

..... &l Real Time Devices LI0-DASIBIR 16

..... 23] 5BS Technaologies -
. | . I _’I—I oo CIO-DASTEIR EXP LI
Ready 4

5 From the block library, click and drag the name of an A/D board to the
Simulink block diagram. Likewise, click and drag the name of a D/A board
to your model.

Simulink adds the new I/O blocks to your model.

6 Remove the Signal Generator block and add the analog input block in its
place. Remove the Scope block and add the analog output block in its place.

The model xpc_osc should look like the figure shown below.
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Filz Edit Wiew Simulation Format Tools  Help
GIO-DAS 180216 10002
GomputerBoams 1 5 |
e
Anabg Input g +400s+1000"2 CIO-DASIB02/16

¥

1 SomputerBoads
CIO-DASIEDZ 16 Transfer Fen An;bg Cutput

¥

Clo-DASTE0Z 16 1

*P3 Tamet tutonal model|

You cannot run this model unless you have the I/O board shown above
installed in your target PC. However, you can substitute the driver blocks
for another I/O board that is installed in the target PC.

Your next task is to define the I/O block parameters. See “Defining I/0 Block
Parameters” on page 1-20
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Defining 1/0 Block Parameters

The I/0O block parameters define values for your physical I/O boards. For
example, I/O block parameters include channel numbers for multichannel
boards, input and output voltage ranges, and sample time.

This procedure uses the Simulink model xpc_osc.mdl as an example, and
assumes you have added an analog input and an analog output block to your
model. To add an I/O block, see either “Adding I/O Blocks with the xPC
Target Library” on page 1-11 or “Adding I/O Blocks with the Simulink Library
Browser” on page 1-15

1 In the Simulink window, double-click the input block labeled Analog
Input.

The dialog box for the A/D converter opens.

2 Fill in the dialog box. For example, for a single channel enter 1 in
the Number of Channels box, select —10 V for the input range, and
select single-ended (16 channels) for the MUX switch position.
Enter the same sample time you entered for the fixed step size in the
Simulation > Configuration Parameters dialog box Solver pane.
Enter the base address for this ISA-bus board.
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The Block Parameters dialog box should look similar to the figure shown
below.

] source Black Parameters: CI0-DAS1602 il

— adcbpeidaz [mazk] [link]

CI0-DAS1E024E
ComputerB oards
Analog Input

—Parameters

MHumber of channels:

Range vector:l + 100 ﬂ
|npLit coupling:l Single-ended [16 channels] LI
Sample time:

joom

Baze address [for example 0xd000]:
0300

Ok I Cancel | Help |

3 In the Simulink window, double-click the output block labeled Analog
Output.

The dialog box for the D/A converter opens.

4 Fill in the dialog box. For example, for one channel enter [1] in the
Channel Vector box; for an output level of —10 V enter the code [-10] in
the Range Vector box. Enter the same sample time you entered for the
fixed step size in the -> Simulation > Configuration Parameters dialog
box Solver pane. Enter the base address for this ISA-bus board.
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The Block Parameters dialog box should look similar to the figure shown

below.

E Sink Block Parameters: CIO-DAS1602 16 1

—dachiza [maszk] [link)

x|

ClO-DASTE02/16
ComputerB oards
Analog Output

—Parameters

Chaninel vectar:

Range vectar:

0]

Resat wector:

=

[f1]

Imitial value wectar:

[

Sample tirme:

J0.001
Baze address [for example Oxd000]);

J (300

Cancel | Help |

[ o |

Apply |

If you change the sample time by changing the target object property
SampleTime, the sample times you entered in both of the I/O blocks are set to
the new value. The step size you entered in the Configuration Parameters

dialog box remains unchanged.

Your next task is to build and run the target application. See “xPC Target

Application” in Getting Started with xPC Target.
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Serial Communications

xPC Target interfaces the target PC to serial devices using either the COM1
or COM2 port of the main board, through Quatech drivers, through Diamond
Systems drivers, or through Commtech drivers. This chapter includes the

following sections:

Introduction to Serial Drivers (p. 2-2)

xPC Target RS-232 and 422/485
Drivers (Composite) (p. 2-5)

xPC Target RS-232 Drivers
(Conventional) (p. 2-19)

Boards and Blocks — Alphabetical
List (p. 2-53)

Description of hardware connections
and host/target PC communications.

Description of composite xPC Target
RS-232/422/485 drivers. Includes
description of procedure to add an
RS-232 driver block to your Simulink
model. Also describes associated
Simulink blocks.

Description of conventional xPC
Target RS-232 drivers. Includes
description of procedures to add an
RS-232 driver block to your Simulink
model and create the message
structures associated with those
blocks. Also describes associated
Simulink blocks and MATLAB
message structures associated with
the Simulink blocks.

Description of block parameters for
serial board driver blocks



2 Serial Communications Support

2-2

Introduction to Serial Drivers

xPC Target supports RS-232 I/O communication with the following:

Serial ports on the target PC
Third-party Quatech PCI boards (http://www.quatech.com)

Third-party Diamond Systems PC/104 boards
(http://www.diamondsystems.com)

For the target PC serial ports, xPC Target can use these ports as the RS-232
I/O devices. You can initiate RS-232 communications with these ports and the
accompanying xPC Target drivers.

xPC Target also supports the following:

RS-232 — QSC-100 and ESC-100 PCI boards from Quatech

RS-422, RS-485 — QSC-200/300 PCI boards and DSCP-200/300 dual
channel PXI boards from Quatech, Fastcom: 422/2-PCI adapter from
Commtech (http://www.commtech-fastcom.com)

RS-232, RS-422, RS-485 — Emerald-MM and Emerald-MM-8 PC/104
boards from Diamond Systems. These boards provide 4 and 8 serial ports,
respectively. These boards are jumper-configurable for the protocols (see
the manufacturer documentation for details).

xPC Target provides a set of functionally similar drivers for these boards. See
“RS-232/422/485 Simulink Block Reference” on page 2-13 for a description of
the driver blocks that support the different protocols.

xPC Target supplies two types of drivers to support RS-232 I/0O
communication, conventional and composite:

The composite drivers support RS-232 I/O for the target PC serial ports,
the Quatech RS-232, RS-422, and RS-485 I/O devices, and the Diamond
Systems RS-232 I/0O devices. These drivers support communication in
asynchronous binary mode. xPC Target uses Simulink blocks for the I/O
drivers. The composite drivers provide a simple ASCII encode/decode

for the send and receive RS-232, RS-422, and RS-485 blocks. This set of
drivers has the descriptive name “composite” because the driver represents


http://www.quatech.com
http://www.diamondsystems.com
http://www.commtech-fastcom.com/

Introduction to Serial Drivers

each functional piece of the driver as a Simulink block. For more precise
behavior, you can customize the RS-232 driver with these blocks.

¢ The conventional drivers support RS-232 I/O only for the target PC serial
ports. These drivers support synchronous, asynchronous, and binary
(asynchronous) communication mode. xPC Target uses a model for this
RS-232 I/0 that includes both Simulink blocks for the I/O drivers and
MATLAB structures for sequencing messages and commands.

This section includes the following topics:

Hardware Connections for RS-232 Connect the target PC to an RS-232

(p. 2-3)

device.

Host and Target PC Communication Consider limitations to using RS-232

(p. 2-4)

for I/O on the target PC when using
RS-232 communication between the
host PC and target PC.

Hardware Connections for RS-232
xPC Target supports serial communication with the COM1 and COM2 ports

on the target PC.

Your target applications can use these RS-232 ports as I/O devices. Typically,
the target PC is connected to an RS-232 device with a NULL modem cable.
However, this depends on the DTE/DCE configuration of the devices, and you
might not use a NULL modem cable.

Tamget PC RS-232
connectian

—

RS-232
Device
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Host and Target PC Communication

If the host PC and target PC are connected using serial communication, one
COM port on the target PC is dedicated for communication with the host PC.
You cannot use this COM port in your block diagram as an I/O device.

For example, if the target PC uses COM1 for the communication with the host
PC, COM1 cannot be used by your block diagram. If you try to use COM1

as an I/O device in your block diagram, an error message is displayed. The
error message appears when you attempt to build and download the target
application. In this example, you must use COM2 as an I/O device in your
block diagram.

If you are using TCP/IP as your host PC to target PC communications
protocol, then you can use any of the COM ports for RS-232 I/0O.

Note When you use composite driver blocks, COM1 and COMS3 often share
interrupt line 4. Similarly, COM2 and COM4 often share interrupt line 3. If
you use COM1 for host-target communication, you cannot also use COM1

or COMS3 in a model. This is because the shared interrupt is caught in the
xPC Target operating system. However, if COM3 uses an interrupt different
from that for COM1, you can use COMS3 in a model while using COM1 for
host-target communications. If COM1 and COMS3 share an interrupt line, you
can use COM2 or COM4 as your RS-232 I/O port.




xPC Target RS-232 and 422/485 Drivers (Composite)

xPC Target RS-232 and 422/485 Drivers (Composite)

This section describes the components that make up the RS-232 and
RS-422/485 composite drivers, and how you can create a model using
these drivers. These drivers perform RS-232 or RS-422/485 asynchronous
communications.

xPC Target supports the target PC serial ports (main board), Quatech
RS-232/422/485 devices, Diamond Systems RS-232 devices, and Commtech
Fastcom: 422/2-PCI adapters with composite drivers. These drivers distribute
the functionality of the device across several subsystems and blocks. For most
RS-232/422/485 requirements, you can use these RS-232/422/485 drivers as
they are implemented. However, if you need to customize the xPC Target
RS-232/422/485 drivers, the composite nature of the target PC serial port,
Quatech RS-232/422/485, Diamond Systems RS-232, and Commtech Fastcom
drivers enables you to do so. See “RS-232/422/485 Internal Blocks and
Subsystems” on page 2-18 for details.

Note the following characteristics of the Commtech Fastcom: 422/2-PCI

adapter boards (http://www.commtech-fastcom.com):

® The Fastcom 422/2-PCI board has only two independent RS-422 channels.

® The Fastcom 422/2-PCI board can handle baud rates up to 1.5 megabaud.

® The Fastcom 422/2-PCI board hardware FIFO is fixed at 128 bytes for
receive and transmit.

This section includes the following topics:

* “Adding RS-232 Blocks” on page 2-6
¢ “Building and Running the Target Application (Composite)” on page 2-12
o “RS-232/422/485 Simulink Block Reference” on page 2-13

Note Many of the blocks that support the RS-232 and RS-422/485 composite
drivers are common across the main board, Quatech, and Diamond Systems

boards. The descriptions for these blocks are applicable for all drivers, with

specific board notes as appropriate.
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Adding RS-232 Blocks

You add RS-232 subsystem blocks to your Simulink model when you want
to use the serial ports on the target PC, Quatech QSC-100 or ESC-100, or
Diamond Systems Emerald-MM or Emerald-MM-8 serial device connected to
the target PC, for I/0.

After you create a Simulink model, you can add xPC Target driver blocks and
configure those blocks. The following procedure describes how to use the
serial ports on the target PC for I/O with the composite drivers.

Before you start, decide what COM port combinations you want to use. The
example has you configure the Baseboard Send/Receive block. To properly
configure this block, you need to select serial port pairs. This parameter
specifies the ports for which you are defining transmit and receive. You have a
choice of the following:

e Comi/none

e Com2/none

e Com1/Com3

e Com2/Com4

® none/Com3

® none/Com4

® Custom

If you choose either the Com1/Com3 or Com2/Comé4 pair, check that the port pair

shares an interrupt. If the port pair does not share an interrupt, you cannot
use the two ports as a pair.

Alternatively, you can define a Custom port pair. A Custom port pair is one
that does not match the existing combinations of port pairs. When you select
Custom, the dialog allows you to configure your own port pair. For example,
you can set the IRQ and two addresses for the port pair. If one of the ports is
not used, set that address to 0.



xPC Target RS-232 and 422/485 Drivers (Composite)

Normally, the ports are set to the following:

COM1 — 0x3F8, IRQ 4

COM2 — 0x2F8, IRQ 3

COMS3 — 0x3ES8 (if present), IRQ 4

COM4 — 0x2ES8 (if present), IRQ 3

A Custom port pair is one where one or both ports of the pair are set to
addresses other than these conventions, or one for which you want to assign
a different IRQ value. Some hardware allows you to set the IRQ numbers
independently.

If you choose the port pairs Com1/Com3 or Com2/Com4, you need to include one
Send/Receive subsystem block in the model. If you choose to use COM1 and
COM2, or COM1 and a custom port pair, you need to include two Send/Receive
blocks in the model.

The following example shows two models, one that uses a standard Com1/Com3
port pair, and one that uses custom port pairs:

1 In the MATLAB Command Window, type

xpclib

The xPC Target driver block library opens.
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2 Double-click the RS-232 group block.

A window with blocks for RS-232 drivers opens.

Note This library contains two sections, composite and conventional.

E! Library: xpclib/R5232 - II:I Iil

File Edit W“iew Format Help

Composzite drivers

]
ASCIH ASCIH RE232

! Encode L e Decode ! L State CF::
ASCI Encode ASCI Decode R5232 State

Quatech  Mainboard  Diamond  Commiech

FIFQ FIFD
F Read E wribe
FIFQ mad FIFC werite
¢ AFO 1 FiFo !
Read HORS 5 Read BINARY;
FIFO ASCI ead FIFD hin iead

Conventional drivers [Obsolete]

RS -232
Mainboar
Satup
Synchmonous Asynchmonous  Binary
Ra232 Mode Mode Mode
RZ232
Mainbaard 1.0 compatible
Setup
Setup

Alternatively, you can access the xPC Target block library from the
Simulink Library Browser. In the Simulink window, and from the View
menu, click Show Library Browser. In the left pane, double-click xPC
Target, and then click RS232.

3 Drag and drop an ASCII Encode block to your Simulink model. This block
encodes input for the RS-232 Send Receive block.

4 Configure this block.



xPC Target RS-232 and 422/485 Drivers (Composite)

5 Drag and drop an ASCII Decode block to your Simulink model. This block
decodes output from the RS-232 Send Receive block.

6 Configure this block.
7 Double-click the Mainboard group block.

8 Depending on your port pair configuration, drag and drop one or two
Baseboard RS-232 Send/Receive blocks to your Simulink model.

9 Double-click the Baseboard RS-232 Send/Receive block.

10 Configure this block. Pay particular attention to the Parameter group
Board Setup entry.

11 Add a Signal Generator and Target Scope block.

12 From the Simulink Library Browser, select Sinks. Depending on your
configuration, drag and drop one or more Terminator blocks. Connect this
block to the unused RCV1 port to suppress unused port messages.

13 From the Simulink Library Browser, select Sources. Depending on your
configuration, drag and drop the Ground block. Connect this block to the
unused XMT3 port to suppress unused port messages.
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Your model should look similar to one of the following figures. The first
figure shows a single-block model. This model uses the Com1/Com3 port

pair. The second figure shows a two-block model. This model uses two sets
of Custom port pairs.

[Z]rsz32mainboard_model 1o =|

File Edit WView Simulation Faormat Tools Help

¥

w0 o .
. ..
<) Pl e D AT RV —

. Temninato
Signal ASCH Encode Easzboard |rminamr
Gienermtor RE232

Send Recaive

- ASGCIH Tamet Scope
E—bxmﬂa a3 L R o a4
Gmund

ASGI Decode

Baszboard Seope RRC)
Seral
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[Z]rsz32mainboard_model2b i [m] 4|
File Edit WYiew Simulation Format Tools Help
nooa ASGI » .
- T
2s3 | Encode | B4 RSV
Signal A5G Encode Bassboard Temintar
GeneRor RSz32
Send Receive
= —5]
Gmound Temninator]
Bassboad
Serial
ASGIH Tamet Scope
T2 RCVE Decode Id: 1
Gmund2
Baszboard ASGI Decode
Rsz3z Seape PG
Send Receive
— =]
Gmundi TeminatorZ
Bazzboamd
Seral

14 Double-click a Baseboard RS232 Send Receive block. Enter values to
configure the port(s) on the target PC for this board.
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For example, if the target PC is connected to COM1, your Send Receive

block dialog box should look similar to the following figure. Note, this is
a dynamic dialog box that changes depending on the Parameter group
selection.

[Z] Function Block Parameters: Baseboard Serial il

—Bazeboard ARS232 Send Receive [mask] (link]

Baseboard
R5232 Send Receive Subsystem

—Parameters

Parameter group: [JaaElgeili

Cnnfiguralion:l Coml/haone LI

0K I Cancel | Help | Apply |

For more information on entering the block parameters, see
RS-232/RS-422/RS-485 Send/Receive.

15 Click OK. The Send Receive block dialog box dialog box closes.

Your next task is to build and run the target application.

Building and Running the Target Application
(Composite)
xPC Target and Real-Time Workshop® create C code from your Simulink

model. You can then use a C compiler to create executable code that runs
on the target PC.

After you have added the RS-232 blocks for the main board to your Simulink
model, you can build your target application.
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Note You cannot use a serial port to communicate between the host PC and
target PC with this example. You can only use COM1 if it is not already in
use for host-target communications. Additionally, if COM1 and COMS3 share
an interrupt, you cannot use COM3 if COM1 is already in use for host-target
communications.

1 In the Simulink window, and from the Tools menu, point to Real-Time
Workshop, and then click Build Model.

2 In the MATLAB Command Window, type

+tg or tg.start or start(tg)

RS-232/422/485 Simulink Block Reference

xPC Target supports RS-232/422/485 communication with driver blocks in
your Simulink model.

This section includes the following topics:

® “Signal Data Types” on page 2-14 — Describes signal data types that
composite drivers support.

® ASCII Encode/Decode — (Generic) Describes encoder and decoder blocks.
Encoders convert input signals for the send/receive subsystem to ASCII
strings. ASCII decoders parse the string from the Send/Receive subsystem.

e FIFO Read/Write — (Generic) Describes FIFO read and write blocks.

e RS232 State — (Generic) Monitors the hardware error state information
that is present in the output vector from all blocks.

o RS-232/RS-422/RS-485 Send/Receive — Provides blocks for sending and
receiving.

® Modem Control — Controls the state of either or both of the RTS and DTR
output lines.

® Modem Status — Reads the states of the four input modem control lines.

* “RS-232/422/485 Internal Blocks and Subsystems” on page 2-18 — Provides
blocks to customize the RS-232/422/485 drivers.

2-13



2 Serial Communications Support

2-14

Signal Data Types

Signals between blocks in composite drivers can be one of several basic data
types, 8-bit and 16- or 32-bit. Both of these types are structures.

8-bit data types are NULL-terminated strings that are represented as
Simulink vectors. The width is the maximum number of characters that can
be stored. In the following figure, M is the actual set of stored characters and N
is the maximum number of characters that can be stored.

|_‘ M b| unused values
[t [e Ju[efo] [w]olr]|o]o] ‘T/
ot N -

This string has 11 characters terminated with a NULL byte (0). This data
type cannot contain a NULL byte as part of the real data.

16- and 32-bit data types use the first element of the vector as a count of the
valid data. In the following figure of a 16-bit data type, C is the count of the
valid data, N is the width of the vector.

[
|-d—i-| unused and
undefined wvalues

| - N -

These serial blocks interpret each entry in the vector as a single character.
The low-level hardware Send block writes the low-order byte of each entry
to the UART. The 16- and 32-bit data types allow the embedding of any 8-bit
data value, including 0.

The 8-bit data type is most useful with the ASCII Encode and Decode blocks.
The 16- and 32-bit data types are most useful for binary data streams.
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Defining the Commtech Fastcom Baud Rate

The Commtech Fastcom 422/2-PCI board can handle baud rates up to 1.5
megabaud. To configure a baud rate for the board, you need to set the
following parameters:

® Clock Bits in the Fastcom 422/2-PCI Send Receive block with the
Parameter group parameter set to Board Setup

¢ Baud Divisor in the Fastcom 422/2-PCI Send Receive block with the
Parameter group parameter set to Basic Setup

The Fastcom 422/2-PCI board has two serial channels, each of which has

an independent counter (baud clock). A master clock generator, which has

a phase locked loop, controls the master clock for both serial channels. The
master clock generates a maximum baud rate for both channels. The block
determines the actual baud rate of a channel by dividing the maximum baud
rate from the master clock by the baud rate divisor (n).

Desired freguency

Max i
Master clock bgﬁumggte

with phase
locked loop Channel 1

i

a, b in Baud Clock

n Baud Clock

Channel 2

Fastcom 422-2 PCI Board

To correctly set the block parameters for this board, choose a maximum baud
rate, as follows. This procedure assumes that both channels require different
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baud rates. Determine a common base clock that can be divided to produce
the required baud rates for both channels, as follows:

1 In the MATLAB Command Window, type a command like the following.
With a desired frequency (for example, 1.5e6) as the desired input, the
fc422mexcalcbits utility calculates parameter values that you can use to
configure the board rate for your board.

[a b df ] = fc422mexcalcbits(1.5€6)

This command returns three values.

a = 12199144
b = 24
df = 1500000

2 Examine the df value. The df value is the actual frequency the board
will be able to attain compared to your desired frequency. If the actual
attainable frequency is not accurate enough, you might want to try another
frequency. In this example, the board can match the desired frequency of
1500000 (1.5€6).
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3 Enter the first two values in the Clock Bits parameter of the Fastcom
422/2-PCI Send Receive block with the Parameter group parameter set

to Board Setup.

E Function Block Parameters: Fastcomm 422/ 2-PCL x|

—R5422/485 Send Receive [mazk)] [link]

Q5 C-200/300
Quatech
RS422/485 Send Receive Subsystem

—Parameters

Paramater qraup: | Board Setup

IR number:

10
Clock Bits [12199144 24] = 1 5B aud Maxl:

|[12133144 24
Slat:

|1

Ok LCancel

| Help | Apply |

After you define a maximum baud rate, you can set a unique baud rate for
each channel by choosing a different baud rate divisor for each channel. For
example, you can have Channel 1 have a baud rate of 750000 (1500000/2) and
Channel 2 have a baud rate of 1500000 (1500000/1). To set Channel 1 to have
a baud rate of 750000, with the Fastcom 422/2-PCI Send Receive block with
the Parameter group parameter set to Basic Setup, set

¢ Port to modify to 1

e Baud Divisor to 2

Note For very slow baud rates (less than 30000), you must use the Baud
Divisor parameter to achieve the desired baud rate.
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RS-232/422/485 Internal Blocks and Subsystems

This section describes the internal blocks of the RS-232/422/485 boards.
Typically, the parameters in these blocks are controlled from the mask
parameters dialog for the send/receive subsystem in which they are used.

You might need to access these blocks if you need to modify the RS-232
Quatech subsystems for your use.

Note Otherwise, do not use these blocks directly.

This section includes the following topics:

RS-232/422/485 Setup (Composite) — Sets up the interface characteristics
for the board.

RS-232/422/485 Read Hardware FIFO (Composite) — Reads characters
from the hardware FIFO in the UART.

RS-232/422/485 Write Hardware FIFO (Composite) — Writes the data from
the input port to the hardware FIFO in the UART for this port.

RS-232/422/485 Read Int(errupt) Status (Composite) — Reads the interrupt
status for the boards in the system.

RS-232/422/485 Enable TX Interrupt (Composite) — Enables the
transmitter buffer empty interrupt when data is present in the software
FIFO.

RS-232/422/485 Filter Interrupt Reason (Composite) — Filters the output
of the Read Int(errupt) Status block.

RS-232/422/485 Board Setup (Commtech) and Interrupt Check (Quatech)
(Composite) — Checks for instances where the hardware IRQ differs from
the software for which it is listening.
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xPC Target RS-232 Drivers (Conventional)

This section describes the components that make up the RS-232 conventional
drivers, and how you can create a model using these drivers. This section
includes the following topics:

“Simulink Blocks for RS-232 I/O (Conventional)” on page 2-19 — Add setup,
send, send/receive, and receive blocks to your Simulink model.

“MATLAB Message Structures for RS-232 I/0 (Conventional)” on page
2-20 — Create message structures to sequence instructions to and from
the RS-232 device.

“RS-232 Synchronous Mode (Conventional)” on page 2-21 — Add
synchronous driver blocks to have the device wait for a response before
continuing with other computations.

“RS-232 Asynchronous Mode (Conventional)” on page 2-31 — Add
asynchronous driver blocks if the device does not have to wait for a response
before continuing with other computations.

“RS-232 Simulink Block Reference (Conventional)” on page 2-44 —
Description of the RS-232 blocks for the conventional drivers.

“RS-232 MATLAB Structure Reference (Conventional)” on page 2-44 —
Description of the RS-232 MATLAB structure for messages.

“RS-232 Binary Mode (Conventional)” on page 2-48 — Add binary driver
blocks to transfer raw data.

Simulink Blocks for RS-232 1/0 (Conventional)

To support the use of RS-232, the xPC Target I/O library includes a set of
RS-232 driver blocks. These driver blocks can be added to your Simulink
model to provide inputs and outputs using one or more of the RS-232 ports.

RS-232 Setup — One setup block is needed for each RS-232 port you use
in your model. The setup block does not have any inputs or outputs, but
sends the initialization and termination messages.

RS-232 Send/Receive (Synchronous Mode) — Send/Receive blocks
have inputs and outputs from your Simulink model, and wait for responses
to messages sent and received.
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e RS-232 Send (Asynchronous Mode) — Send blocks have inputs from
your Simulink model, and wait for responses to messages sent.

¢ RS-232 Receive (Asynchronous Mode) — Receive blocks have output
from your Simulink model, and wait for responses to messages received.

MATLAB Message Structures for RS-232 1/0
(Conventional)

Communication is through a series of messages passed back and forth
between the target PC and the RS-232 device. To accomplish this, the
messages sent to the RS-232 device must be in a format that the device
understands. Likewise, the target PC must know how to interpret the data
returned from the RS-232 device.

xPC Target uses MATLAB structures to create messages and map the input
and output ports on the RS-232 driver blocks to the data written and read
from the RS-232 devices. The RS-232 Setup block sends the messages in the
initialization structure after downloading the target application. The RS-232
Send/Receive, RS-232 Send, and RS-232 Receive blocks repeat the sending of
the messages in the send/receive, send, and receive structures during each
sample interval. When the target application stops running, the RS-232 Setup
block sends the messages in the termination structure.

Below is an example of the send and receive message structure for
asynchronous communication. In this example, an external RS-232 device
requires a string with two floating-point numbers. The numbers are entered
from the Simulink model to the first and second input ports of the RS-232
Send driver block. The RS-232 device sends back two floating-point numbers
that are passed to the outputs of the RS-232 Receive driver block.
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RSEEE_STend

] |
Es232 _]Send[lj . RSEE[E_Scnd[nJ

SendData-‘start, 3£, %f,stop: ;"
JnputPorts [1, 2]
Timeoutrd . 01

RS23 E_IR[’ﬁcclve

I l
RS2 331Rcceivcu} Ce RSEB‘[E_Rﬁceivc[nJ

RecData-‘start, 3£, 3£, stop: 4, °
LOurputPorts [1, 2]

Timeout .01

Eom- 1

For more information on this example, see “Creating RS-232 Message
Structures (Asynchronous)” on page 2-39.

RS-232 Synchronous Mode (Conventional)

Use synchronous mode when you need to receive a response before continuing
with other computations. In synchronous mode, data is sent to an external
device and the driver block waits for a response. In other words, the I/O driver
blocks or stops execution of the target application until an answer is received
from the external device or it reaches a time-out. This section includes the
following topics:

* “Notes for RS-232 Synchronous Mode” on page 2-22 — Overview of RS-232
communication with xPC Target blocks.

® “Adding RS-232 Driver Blocks (Synchronous)” on page 2-22 — Add the
setup, send, and receive blocks you need to your Simulink model for RS-232
communication.

® “Creating RS-232 Message Structures (Synchronous)” on page 2-28 —
Create the initialize, send/receive, and termination message structures you
need in the MATLAB workspace.
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Notes for R$-232 Synchronous Mode

For the example in this section, assume an external device (RS-232 device)
includes a D/A conversion module with four independent channels and an
output voltage range of -10 to 10 volts. Also assume that the external device
outputs a new voltage if it receives a serial string with a value to identify the
D/A channel and the voltage value.

Use a Constant block as an input to the Send/Receive block to select the D/A
channel, and a Signal Generator block as a source for voltage values. Also,
set up the message structures to receive a confirmation message from the
external module after the target PC sends a message string to the device.

In synchronous mode, the data is sent to the external device and the block

waits until a response (for example, data) is received from the device before
the execution of the block is considered to be complete. In other words, the

I/O driver blocks until an answer is received from the external device or

it reaches a time-out.

When it is necessary to receive a response before continuing with other
computations, synchronous mode is used, which implies that the Send &
Receive block is placed in your model. This block includes both input and
output lines.

Adding RS-232 Driver Blocks (Synchronous)

You add RS-232 driver blocks to your Simulink model when you want to use
the serial ports on the target PC for 1I/O.

After you create a Simulink model, you can add xPC Target driver blocks and
define the initialization, send/receive, and termination message structures:

1 In the MATLAB command window, type

xpclib

The xPC Target driver block library opens.
2 Double-click the RS-232 group block.

A window with blocks for RS-232 drivers opens.
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Note This library contains two main sections, Composite drivers and
Conventional drivers. Refer to the Conventional drivers section, where
there are two setup blocks. The second block is included for compatibility

with xPC Target Version 1.0.

E! Library: zpclib/RS232

File Edit W“iew Format Help
Composzite drivers
ASCH ASCH p Rs22 [
Encode Decode State  p
ASCI Encode ASCI Decode R5232 State
Quatech  Mainboard  Diamond  Commiech
p RO . FIFO
Read wribe
FIFQ mad FIFC werite
FiFo ! FiFo !
Read HORS 5 He acl BINARY;
FIFO ASCI ead FIFD hin iead

Rs 232
Mainboard
Satup

RE232

RZ232
Mainboad
Setup

Setup

Conventional drivers [Obsolete]

o BBl

Sy nchrunous Asy nchrnnous

1.0 compatible

Binary
Mode

Alternatively, you can access the xPC Target block library from the
Simulink Library Browser. In the Simulink window, and from the View
menu, click Show Library Browser. In the left pane, double-click xPC

Target, and then click RS-232.

3 From the Conventional drivers area, drag and drop an RS-232 Setup block

to your Simulink model.

4 In the Library window, double-click the RS-232 Synchronous mode
group block. The library window with blocks for RS-232 synchronous

communication

opens.
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Note This library contains two Setup and Receive blocks. The second block
is included for compatibility with xPC Target Version 1.0.

E!Lihrar'y: spcliby Y [m]

File Edit Wew Formatb Help

RS232
flzinboznd
Send/Receine

R5232

1.0 compatible

RS232
ftzin bozd
Send/Receine

Send & Receine

5 Drag and drop an RS-232 Send/Receive block to your Simulink model.

6 Add a Signal Generator and a Constant block.
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Your model should look similar to the figure shown below. Note that inputs
on the RS-232 Send/Receive block are not defined or visible. The inputs are
defined in a MATLAB message structure, and visible only after you load

that structure into the MATLAB workspace and update your Simulink
model.

JRT=TE

File Edit Wiew Simulation Format Tools  Help

1

Constant
RS232 RS232
zinboad hizinbozmrd
Setup Send/Receine
RS22E2 1 RE232
oooo
Lelv]
Signal
Gienemtor

7 Double-click the RS-232 Setup block. Enter values to configure the COM1
port on the target PC.

For example, if the target PC is connected to COM1, and serial

communication is set to 5760 baud, 8 data bits, and 1 stop bit, your Block
Parameter dialog box should look similar to the figure shown below.
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Note If you are not using an initialization or termination structure, in the
Initialization Struct and Termination Struct boxes, enter the empty
matrix [].

E Block Parameters: R5232 x|

—rs232zetup [mask] [link]

RS-232
t ainboard
Setup

—Parameters

Port v

Baud rate: | 57600

MHumber of data bits:l g

Humber of ztop bits:l 1

F'alit_l,J:I Mone

Lol Lef Lo L] Le

F'lotncnl:l Mane

Send buffer size:

1024

Receive butfer size:

1024

Initialization command structure:
[i

Termination command structune:

i

ok I Cancel | Help | Apply |

For more information on entering the block parameters, see RS-232
Mainboard Setup (Conventional). For the procedure to create the
initialization and termination structures, see “RS-232 MATLAB Structure
Reference (Conventional)” on page 2-44.

8 Click OK. The Block Parameters dialog box closes.
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9 Double-click the RS-232 Send/Receive block. The Block Parameters dialog
box opens.

10 From the Port list, select either COM1 or COM2. For this example, select
COM1. In the Message struct name box enter the name for the MATLAB
structure this block uses to send messages to the COM1 port. The name of
the message structure is not the name of the M-file, but the name of the
structure created with the M-file.

In the Sample Time box, enter the sample time or a multiple of the sample
time you entered in the Receive block.

Your Block Parameter dialog box should look similar to the figure shown
below.

—ra232zendrec [mazk] [link)]

RS5-232
b ainbioard
Send/Feceive

—Parameters

Part: | COM1 |

Meszage stuct name;
|R5232_Sknd_Receive

Sample tirme:
jo

(]9 LCancel | Help | Apply |

For information on entering the block parameters, see RS-232 Mainboard
Send/Receive (Synchronous) (Conventional). For the procedure to create
the send/receive structure, see “RS-232 MATLAB Structure Reference
(Conventional)” on page 2-44.

11 Click OK. The Block Parameters dialog box closes.
Your next task is to create the MATLAB message structures that the RS-232

driver blocks use to sequence commands to the RS-232 device. See “Creating
RS-232 Message Structures (Synchronous)” on page 2-28.
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Creating RS-232 Message Structures (Synchronous)

RS-232 drivers use MATLAB structures to send and receive messages and
map the input and output ports on the RS-232 driver blocks to the data
written and read from the RS-232 devices.

After you add an RS-232 Setup and RS-232 Send/Receive block to your
Simulink model, you can create the message structures to communicate with
the RS-232 devices. You need to create and load these structures into the
MATLAB workspace before you build your target application. The easiest way
to create these structures is using an M-file and loading that M-file into the
MATLAB workspace.

1 In the MATLAB Command Window, and from the File menu, point to
New, and then click M-file.

A MATLAB text editor window opens.

2 Enter the initialization, send/receive, and termination messages. Each
message is an element in a MATLAB structure array. For information and
examples of this structure, see “RS-232 MATLAB Structure Reference
(Conventional)” on page 2-44.

For example, assume that you have an external RS-232 device with a

D/A module that requires a string in the format 'identifier, channel,
value;\n'. identifier is any string. channel is an integer value between
1 and 2, defining which D/A channel to update. value is a floating-point
value indicating the new voltage for the D/A output.

Additionally, when the external device receives a legal string, it accepts
the string as an input message and returns the message 'noerror;\n'.
This message is provided as a confirmation. As an example, you can type
the following.

Note Field names in the structures are case sensitive.
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RS232_Send_Receive(1).SendData = 'da_1234,%d,%f,;\n';
RS232_Send_Receive(1).InputPorts = [1 2];
RS232_Send_Receive(1).RecData = 'noerror\n';
RS232_Send_Receive(1).Timeout = 0.01;
RS232_Send_Receive(1).EOM = 1;

3 From the File menu, click Save As. In the Save as file dialog box, enter
the name of the M-file script. For example, enter

RS232Sync_Messages.m

4 Close the text editing window.

5 In the MATLAB Command Window, type the name of the M-file you created
with the RS-232 structures. For example, type

RS232Sync_Messages

MATLAB loads and runs the M-file to create the message structures in the
MATLAB workspace needed by the RS-232 driver blocks.

6 Open your Simulink model, or press Ctrl+D.

Simulink updates the RS-232 driver blocks with the information from the
structures. For example, Simulink adds inputs and outputs defined in
the structures to the blocks.

7 Connect the input and output ports on the RS-232 driver blocks to other
blocks in your Simulink model.
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Your model should look similar to the figure shown below.

Zlrs232sync ] 4

File Edit Wiew Simulation Format Tools Help

1
Sonstant
RS.232 1 RS232

zinboad ftzin ooz
Setup 2 Send/Recaie
RS22E2 1 RS232
oooo
[ele]
Signal
Genembor

8 Set the PreLoadFcn for your Simulink model to load the message structures
when you open your model. For example, if you saved the message
structures in the M-file RS232Sync_messages, type

set_param(gcs, 'PreLoadFcn','RS232Sync_messages.m')

Note If you do not manually load the message structures before opening your
Simulink model, or have the message structures automatically loaded with
the model, the port connections to the RS-232 driver break.

Your next task is to build and run the target application. However, the
example above only illustrates how to set up the dialog entries when using
the Send & Receive block. Without an external RS-232 device to receive

the messages and return a reply 'no error\n', this model cannot run
successfully on your target PC. It will block and wait for a reply each time the
application sends a message.
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RS-232 Asynchronous Mode (Conventional)

Use asynchronous mode when you do not need a response before continuing
with other computations. You can achieve faster sample rates with
asynchronous mode because neither the Send nor Receive block waits for

a reply. As a result, the asynchronous mode blocks do not block as do the
synchronous mode blocks. The application updates the received outputs only
when the entire package of data is received from the external device. This
section includes the following topics:

Notes for RS-232 Asynchronous Overview of RS-232 communications
Mode (p. 2-31) with xPC Target blocks.

Adding RS-232 Driver Blocks Add the setup, send, and receive
(Asynchronous) (p. 2-32) blocks you need to your Simulink

model for RS-232 communication.

Creating RS-232 Message Structures Create the initialize, send/receive,
(Asynchronous) (p. 2-39) and termination message structures
you need in the MATLAB workspace.

Building and Running the Target Run a real-time application with
Application (Asynchronous) (p. 2-42) RS-232 communication.

Notes for R$-232 Asynchronous Mode

For the example in this section, two asynchronous mode blocks illustrate how
you can test RS-232 I/O on the target PC in a simple loop-back test. This
simple but effective test lets you check that the RS-232 Send and RS-232
Receive blocks work correctly with your system using minimal hardware.

In this loop-back test, you use the COM1 port for sending signals and the
COM2 port for receiving signals. A NULL modem serial cable connects COM1
to COM2 so that any messages sent from the target PC through COM1 are
received by COM2 on the same target PC.

Use a Sine Wave block as an input to an RS-232 Send block that you connect
to the COM1 port. Connect the COM2 port to an RS-232 Receive block. The
signal received from this block is then passed through a Gain block of -1.

In the asynchronous mode, data is sent without waiting for response data
to be received. The Send block completes execution immediately upon
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completing the Send transfer. The Receive block completes execution upon
completing the Receive transfer or when no more data is ready to be retrieved.

For sending data in asynchronous mode, use the RS-232 Send block. This
block only has input lines for the data to be sent. For receiving data, you
must use the Receive block. This block only has output lines for the data
to be received. Outputs are updated only when the entire package of data
is received from the external device.

Adding RS-232 Driver Blocks (Asynchronous)

You add RS-232 driver blocks to your Simulink model when you want to use
the serial ports on the target PC for 1/O.

After you create a Simulink model, you can add xPC Target driver blocks and
define the initialization, send, receive, and termination message structures:

1 In the MATLAB Command Window, type

xpclib

The xPC Target driver block library opens.
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2 Double-click the RS-232 group block.

A window with blocks for RS-232 drivers opens.

E! Library: xpclib/R5232 - II:I Iil

File Edit W“iew Format Help

Composzite drivers

]
ASCIH ASCIH RE232

! Encode L e Decode ! L State CF::
ASCI Encode ASCI Decode R5232 State

Quatech  Mainboard  Diamond  Commiech

FIFQ FIFD
F Read E wribe
FIFQ mad FIFC werite
FiFo ! ¢ AFO 1
Read HORS 5 Read BINARY;
FIFO ASCI ead FIFD hin iead

Conventional drivers [Obsolete]

RS -232
Mainboar
Satup
Synchmonous Asynchmonous  Binary
Ra232 Mode Mode Mode
RZ232
Mainbaard 1.0 compatible
Setup
Setup

Alternatively, you can access the xPC Target block library from the
Simulink Library Browser. In the Simulink window, and from the View
menu, click Show Library Browser. In the left pane, double-click xPC
Target, and then click RS-232.

3 Drag and drop two RS-232 Setup blocks to your Simulink model.

4 In the Library window, double-click the RS-232 Asynchronous mode group
block. The library window containing blocks for RS-232 Synchronous
communication opens.
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Note This library contains two send and two receive blocks. The second
block is included for compatibility with xPC Target Version 1.0.

ZLibrary: #pclib/R5232 /Asyne o ] 4
File Edit Wiew Format Help
R5-232 RS-232
ftzin oo zd Irtzin ooz
Send Rexaine
RSE32 R5E2321
W1.0 compatible
RSE32 RSE32
futzin boozud fizin bozd
Send Receie
Send Rece e

Alternatively, you can access the xPC Target block library from the
Simulink Library Browser. In the Simulink window, and from the View
menu, click Show Library Browser. In the left pane, double-click xPC
Target, and then click RS-232.

5 Drag and drop the RS-232 Send and RS-232 Receive blocks into your
Simulink model.

6 Add a Signal Generator, Gain, and xPC Target Scope block.
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Your model should look similar to the figure below. Note that you cannot
connect to the inputs on the RS-232 Send block and the outputs on the
RS-232 Receive block, because they are not defined or visible. The inputs
and outputs are defined in a MATLAB message structure, and visible only
after you load that structure into the MATLAB workspace and update
your Simulink model.

E!r5232async - ||:||ﬂ
File Edit Wiew Simulation Format Tools  Help
RS-232 RS-232
oooo RS 232
e Mitzinbosd fizinboad fvlzinbozmd
Send Setup Setup
Signal
Senembor Rezaz REzZ32 2 RS232 3
>
Tamet Scope
R5-232 14 1
fulzin boozod
Rieceine
Gain Scope (xPC)
RS232 1

7 Double-click the first RS-232 Setup block. Enter values to configure the
COM1 port on the target PC.

For example, if the COM1 and COM2 ports of the target are connected with
a RS-232 NULL modem cable, and you set serial communication to 57600
baud, 8 data bits, and 1 stop bit. Your Block Parameters dialog box should
look similar to the figure shown below.
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Note If you are not using an initialization or termination structure, in the
Initialization Struct and Termination Struct boxes, enter the empty
matrix [].

—ra232zetup [mask] [link]

RS-232
b ainbioard
Setup

—Parameters

Port: h

Baud rate: I B7E00

Mumber of data bits: I a

Mumber of ztop bits: I 1

Parity: I Mare

Lol Lef o] Lef Lo

Protocol: I Maone

Send buffer size:

[1024

Receive buffer size:

J1024

Initialization command structure:
i

Termination command stuctune:

i

0K Cancel | Help | Apply |

For more information on entering the block parameters, see RS-232
Mainboard Setup (Conventional). For the procedure to create the
initialization and termination structures, see “RS-232 MATLAB Structure
Reference (Conventional)” on page 2-44.

8 Click OK. The Block Parameters dialog box closes.
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9 Repeat the previous setup for the second RS-232 Setup block and the
COM2 port. Use the same Baudrate, Databits, Stopbits, Parity, and
Protocol that you entered in the first RS-232 Setup block.

10 Double-click the Send block. The Block Parameters dialog box opens.

11 From the Port list, select either COM1 or COM2. For this example, select
COM1. In the Message struct name box, enter the name for the MATLAB
structure this block uses to send messages to the COM1 port. In the box,
enter the sample time or a multiple of the sample time you entered in the

RS-232 Receive block.

Your Block Parameters dialog box should look similar to the figure shown

below.

[Z]Block Parameters: R5232

—ra232zend [mask] (link)

2%

RS5-232
b ainbioard
Send

—Parameters

Port: I COm1

Meszage stuct name;

|R5232_Send

Sample tirme:

jo

0] 8 LCancel | Help

Apply |

For information on entering the block parameters, see RS-232 Mainboard
Send (Asynchronous) (Conventional). For the procedure to create the send
structure, see “RS-232 MATLAB Structure Reference (Conventional)” on

page 2-44.

12 Click OK. The Block Parameters dialog box closes.

13 Double-click the RS-232 Receive block.

14 The Block Parameters dialog box opens.
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15 From the Port list, select either COM1 or COM2. For this example, select
COM2. In the Message Struct Name box, enter the name for the MATLAB
structure this block uses to receive messages from the COM2 port. In the
Sample Time box, enter the sample time or a multiple of the sample time
you entered in the RS-232 Send block.

Your Block Parameters dialog box should look similar to the figure shown
below.

—ra232rec [mask] (link)

RS5-232
b ainbioard
Receive

—Parameters

Part: | COM2 |

Meszage stuct name;
|R5232_Receivel

Sample tirme:
jo

0] 8 LCancel | Help | Apply |

For information on entering the block parameters, see RS-232 Mainboard
Receive (Asynchronous) (Conventional). For the procedure to create the
send structure, see “RS-232 MATLAB Structure Reference (Conventional)”
on page 2-44.

16 Click OK. The Block Parameters dialog box closes.

17 Double-click the Signal Generator block and enter parameters. For
example, from the Wave Form list, select sine. In the Amplitude and
Frequency boxes, enter 1. From the Units list, select Hertz. Click OK.

18 Double-click the Gain block and enter parameters. For example, in the
Gain box, enter -1. Click OK.
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Your next task is to create the MATLAB message structures that the RS-232
driver blocks use to sequence commands to the RS-232 device. See “Creating
RS-232 Message Structures (Synchronous)” on page 2-28.

Creating RS-232 Message Structures (Asynchronous)

RS-232 drivers use MATLAB structures to send and receive messages and
map the input and output ports on the RS-232 driver blocks to the data
written and read from the RS-232 devices in synchronous mode.

After you add the RS-232 Setup, Asynchronous Send, and Asynchronous
Receive blocks to your Simulink model, you can create the message structures
to communicate with the RS-232 devices. You need to create and load

these structures into the MATLAB workspace before you build your target
application. The easiest way to create these structures is to use an M-file and
load that M-file into the MATLAB workspace. See xpcrs232vV2.mdl in the
xpcdemos directory for an example model. That example sends and receives
two floating-point numbers. In that example, both floating-point number
fields for SendData are filled from InputPorts 1 because only one input port
is specified. In the case of RecData, the first floating-point number field is
sent to OutputPorts 1, but the second floating-point number field is ignored
because only one output port is specified.

The following procedure describes how to create an RS-232 message structure
to send and receive one floating-point number:

1 In the MATLAB Command Window, and from the File menu, point to
New, and then click M-file.

A MATLAB text editor window opens.

2 Enter the initialization, send, receive, and termination messages. Each
message is an element in a MATLAB structure array with a series of
fields For information and examples of these fields, see “RS-232 MATLAB
Structure Reference (Conventional)” on page 2-44.

For example, if you want to send and receive one floating-point number,
type the following. In this example, the floating-point number field

for SendData is filled from InputPorts 1. In the case of RecData, the
floating-point number field is sent to OutputPorts 1.
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Note Field names in the structures are case sensitive.

RS232_Send(1).SendData = 'start,%f,%f,stop;\r';
RS232_Send(1).InputPorts = [1];
RS232_Send(1).Timeout = 0.01;

RS232_Send (1) .EOM = 1;

RS232_ Receive(1).RecData = 'start,%f,%f,stop;\r';
RS232_Receive(1).OutputPorts = [1];
RS232_Receive(1).Timeout = 0.01;
RS232_Receive(1).EOM = 1;

Py

Note If you do not manually load the message structures before opening
your Simulink model, or have the message structures automatically loaded
with the model, the port connections to the RS-232 blocks break.

If you want to send more than one variable, for example three, in a single
frame, use the following RS232_Receive(1).0utputPorts line. This line
sends the first %f data to output port 1, the second %f to output port 2,
and the third %f to output port 3.

RS232_ Receive(1).OutputPorts = [1 2 3];

3 From the File menu, click Save As. In the Save As File dialog box, enter
the name of the M-file. For example, enter

RS232Async_Messages.m
4 Close the text editing window.

5 In the MATLAB Command Window, type the name of the M-file you created
with the RS-232 structures. For example, type

RS232Async_Messages

MATLAB loads and runs the M-file to create the message structures in the
MATLAB workspace needed by the RS-232 driver blocks.

6 Open your Simulink model, or press Ctrl+D.
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Simulink updates the RS-232 driver blocks with the information from the
structures. For example, Simulink adds the inputs and outputs defined in

the structures to the blocks.

7 Connect the input and output ports on the RS-232 driver blocks to other
blocks in your Simulink model.

Your model should look similar to the figure shown below.

T=TE

File Edit Wiew Simulation Format Tools  Help

oooo RSE232 RS232 RSE232
el 1 Mainbozamd fizinboad fvlzinbozmd
Send Setup Setup
Signal
Senembor RSE32 REzze 2 RS232 3
>
R5-232 Targrla; :E‘.Ico pe
hizinboad 1
Rieceine
Gain Scope (xPC)
RSE2321

8 Set the preload function for your Simulink model to load the message
structures when you open the model. For example, if you saved the message
structures in the M-file RS232async_messages, type

set_param(gcs, 'PreLoadFcn','RS232async_messages')

Note If you do not manually load the message structures before opening your
Simulink model, or have the message structures automatically loaded with
the model, the port connections to the RS-232 blocks break.

Your next task is to build and run the target application.
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Building and Running the Target Application (Asynchronous)
xPC Target and Real-Time Workshop create C code from your Simulink
model. You can then use a C compiler to create executable code that runs
on the target PC.

After you have added the RS-232 blocks for asynchronous mode to your
Simulink model, and created and loaded the RS-232 structures into the
MATLAB workspace, you can build your target application.

Note You cannot use a serial port to communicate between the host PC and
target PC with this example. You can only use COM1 if it is not already in
use for host-target communications.

1 In the Simulink window, and from the Tools menu, point to Real-Time
Workshop, and then click Build Model.

2 In the MATLAB Command Window, type

+tg or tg.start or start(tg)

The target application begins running in real time.

For each sample period, the RS-232 messages you entered in the RS-232
send and receive message structures are executed.
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In this example, the target PC displays the inverted waveform. The RS-232
Send and RS-232 Receive blocks require a minimum delay or one sample
to send the data and also receive it. When running at faster sample rates,
several sample intervals might elapse while one set of data is transmitted,
because RS-232 communication is not particularly fast. The sample delay
just described is not visible in this example.

- ——
¢ Real-Time xPC Target Spy I =] B3

xpocrs232 Scope! 1., signal B added

Z9ME Scope! 1, signal 2 added

i Scope: 1, trigger signal set to 2

RT. 1 -

t 3 jl:gte Scope: 1, trigger level set to B.000000

380 4 Scope: 1, TriggerScope set to 1

Scope: 1, lower y-axis limit set to B.000000

@.e1 Scope: 1, upper y-axis limit set to O.000000

@.0001527 System: initializing application finished

31.58 s System! execution started (sample time:!: @.01000@)

a2
y / \\ // \\ / \\ //

You can extend this example for multiple D/A channels by simply adding
more input signals and modifying the format string to have additional '%f"
format specifiers.

Note This example requires that you not use host PC to target PC
communication using a serial port because that would block that COM port
and the example would not operate.
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RS-232 Simulink Block Reference (Conventional)

xPC Target supports RS-232 communication with driver blocks in your
Simulink model and message structures in the MATLAB workspace.

This section includes the following topics:

e RS-232 Mainboard Setup (Conventional) — Sends the initialize and
termination messages. You need one Setup block for each RS-232 port
you use in your model.

e RS-232 Mainboard Send/Receive (Synchronous) (Conventional) —
Sequences the send and receive messages for synchronous serial
communication.

® RS-232 Mainboard Send (Asynchronous) (Conventional) — Sequences the
send messages.

e RS-232 Mainboard Receive (Asynchronous) (Conventional) — Sequences
the receive messages.

RS-232 MATLAB Structure Reference (Conventional)

You do not use all message fields in all messages. For example, a message
to send data would not use the message field.RecData, but would use the
field .SendData. However, knowing the possible message fields is helpful
when you are creating any of the message structures. This section contains
the following topics:

® “RS-232 Send/Receive Message Structure (Synchronous)” on page 2-45 —
Description of the message fields for the send/receive structure associated
with RS-232 asynchronous mode and the RS-232 Send/Receive block

o “RS-232 Send Message Structure (Asynchronous)” on page 2-46 —
Description of the message fields for the send structure associated with
RS-232 synchronous mode and the RS-232 Send block

o “RS-232 Receive Message Structure (Asynchronous)” on page 2-47 —
Description of the message fields for the receive structure associated with
RS-232 synchronous mode and the RS-232 Receive block

® “Supported Data Types for Message Fields” on page 2-47 — List of
supported data types and the format you use to indicate those types in
message fields
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RS-232 Send/Receive Message Structure (Synchronous)

Below are descriptions of the possible message fields for the send/receive
structures with asynchronous mode. The order of the fields does not matter.
However, the field names are case sensitive.

Message Field

Description

SendData

Data and format sent to the RS-232 device. Default
value = '

Note that the SendData syntax format is the same
as the C printf () library function. It is also very
similar to the MATLAB fscanf method, with the
exception that SendData is not vectorized.

InputPorts

Number of input ports for the driver block. Data from
the input ports is sent to the RS-232 device with the
message field.SendData. Default value = []. The
highest number you enter determines the number of
input ports on the driver block

For example, the following message creates two input
ports on the driver block,

RS232_Send _Receive(1).InputPorts= [1 2];

RecData

Data and format received from the RS-232 device.
Default value = ' '. The format of this statement is
very similar to a scanf statement. The read data is
mapped to the output ports defined in the message
field .OutputPorts. If a negative output port is given,
the data is read in, but not sent to any output port.

OutputPorts

Number of output ports from the driver block. Data
received from an RS-232 device is sent to the output
ports with the message field .RecData. Default value
= []. The highest number you enter determines the
number of output ports on the driver block.

For example, to use output ports 1 and 2 on the driver
block, type

RS232_Send_Receive.OutputPorts = [1 2];
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Message Field

Description

Timeout Time, in seconds, the driver block waits for data to be
returned. Default value = 0.049.
EOM Number of characters you use to indicate the end of

a message.

RS-232 Send Message Structure (Asynchronous)

Below is a description of the possible message fields for the send structure
with synchronous mode. The order of the message fields does not matter.
However, the field names are case sensitive.

Message Field

Description

SendData

Data and format sent to the RS-232 device. Default
value = '

Note that the SendData syntax format is the same as
the C printf () library function. It is also very similar
to the MATLAB fscanf method, with the exception
that SendData is not vectorized.

InputPorts

Number of input ports for the driver block. Data from
the input ports is sent to the RS-232 device with the
message field .SendData. Default value = []. The
highest number you enter determines the number of
input ports on the driver block.

For example, the following message creates two input
ports on the driver block.

RS232_Send Receive(1).InputPorts= [1 2];

Timeout

Time, in seconds, the driver block waits for data to be
returned. Default value = 0.049.

EOM

Number of characters you use to indicate the end of
a message.
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RS-232 Receive Message Structure (Asynchronous)

Below are descriptions of the possible message fields for the receive message
structure with synchronous mode.

Message Fields Description
RecData Data and format received from the RS-232 device.
Default value = ' '. The format of this statement

is very similar to a scanf statement. The read
data is mapped to the output ports defined in the
message field .OutputPorts. If a negative output
port is given, the data is read in but not sent to any
output port.

OutputPorts Number of output ports from the driver block.
Data received from an RS-232 device is sent to
the output ports with the message field .RecData.
Default value = [ ]. The highest number you enter
determines the number of output ports on the
driver block.

For example, to use output ports 1 and 2 on the
driver block,

RS232_Send_Receive.OutputPorts = [1 2];

Timeout Time, in seconds, the driver block waits for data to
be returned. Default value = 0.049.

EOM Number of characters you use to indicate the end
of a message.

Supported Data Types for Message Fields

The following table lists the supported data types for the RS-232 message
fields.

Format Description

%c and %C Single character

%d or %1 Signed decimal integer
Su Unsigned decimal integer
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Format Description

o°
(@)

Unsigned octal integer

%X Or %X Unsigned hexadecimal integer using 'abcdef' or
"ABCDEF ' for the hexadecimal digits

%e or %E Exponential format using e or E

%t Floating point

%Q Signed value printed in f or e format depending on

which is smaller

o°
®»

Signed value printed in f or E format depending on
which is smaller

RS-232 Binary Mode (Conventional)

Use RS232 Binary mode when you want to transfer raw data. The format of
this data is either a custom format or is an image of the bytes as they are
stored in memory. This section includes the following topics:

“RS-232 Binary Mode I/O” on page 2-48 — When to use RS-232 binary mode

e “RS-232 Binary Mode I/0” on page 2-48 — How to select drivers from the
xPC Target block library

e RS-232 Binary Receive (Conventional) — Explanation of block parameters,
inputs, and outputs

¢ RS-232 Binary Send (Conventional) — Explanation of block parameters
and input

¢ “Example Using RS-232 Binary Mode I/O” on page 2-51 -— Simulink model
using xPC Target driver blocks

RS-232 Binary Mode 1/0

The binary mode drivers operate in asynchronous mode. In other words, they
do not wait until an entire packet of data is received, but receive as many
bytes as available and then go on to the next data block. When an entire
packet has been received, the block outputs the new data. Sent data is also
handled similarly. The Send block instructs the RS-232 hardware to send a
certain number of bytes, but does not wait for these bytes to actually be sent.



xPC Target RS-232 Drivers (Conventional)

The RS-232 binary mode infrastructure also includes blocks to pack and
unpack any data received. This translates the raw bytes into signals that
Simulink can understand.

The functioning of these blocks is identical to the corresponding blocks in the
UDP section of the xPC Target block library. The RS232 Binary Pack and

Unpack blocks are actually references to these blocks. For information about
UDP and the functionality of these blocks, see Chapter 6, “UDP I/O Support”

Using RS-232 Binary Mode

To use the RS-232 binary mode blocks, you must first insert exactly one RS232
Setup block for each COM port into your model. The setup for this block

is exactly the same as it is for text-based I/O, except that initialization or
termination structures are ignored. In the dialog box, set both these fields to
the empty matrix